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Introducing Adobe Persuasion 4.0

 

elcome to Adobe Persuasion

 

®

 

, the 
world’s leading professional presenta-
tion program. Whether you’re a novice 

or an expert user, you will appreciate the enhanced 
capabilities of Adobe Persuasion 4.0. These 
enhancements include the support for a wide vari-
ety of text and graphics, improved cross-platform 
support, the ability to deliverpresentations on the 
World Wide Web, and a work environment consis-
tent with other Adobe applications, such as Adobe 
Illustrator

 

®

 

 and Adobe Photoshop

 

®

 

. 

 

About this guide

 

This book is for first-time users, as well as users 
upgrading to Persuasion from an earlier version of 
the program. 

 

Adobe Persuasion 4.0 Getting Started

 

 
contains the following information:

 

•

 

Instructions for installing Adobe Persuasion 4.0 

 

•

 

Information for users upgrading from an earlier 
version

 

•

 

A summary of what’s new and what’s different in 
Persuasion 4.0

 

•

 

Tips on improving system performance

 

•

 

Instructions on using Adobe Type Manager and 
the PowerPoint

 

®

 

 File Converter—two additional 
programs installed with Persuasion 4.0

 

Macintosh system requirements

 

To use Adobe Persuasion 4.0 on a Macintosh, you 
need the following hardware and software:

 

•

 

An Apple Macintosh with a 68030 (or greater) 
processor or a Power Macintosh

 

•

 

Apple system software 7.1 (or later) for a 
68000-family Macintosh or 7.5 (or later) for a 
Power Macintosh

 

•

 

A minimum of 8 MB of RAM available to 
Persuasion

 

•

 

At least 20 MB of free hard-disk space

 

•

 

A CD-ROM drive for installation

In addition, Adobe Systems recommends the 
following: 

 

•

 

A 68040 (or greater) processor or a Power 
Macintosh

 

•

 

16 MB of RAM available to Persuasion

 

•

 

40 MB of free hard-disk space

 

•

 

A 16-bit or greater graphics card

W
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Introducing Adobe Persuasion 4.0

 

Windows system requirements

 

To use Adobe Persuasion 4.0 in Windows you need 
the following hardware and software:

 

•

 

A 486-based (or faster) processor

 

•

 

Microsoft Windows 95 or Windows 3.1 with 
MS-DOS 5.0 or later 

 

•

 

A minimum of 8 MB of RAM available to 
Persuasion

 

•

 

20 MB of free hard-disk space

 

•

 

An 8-bit graphics card 

 

•

 

A CD-ROM drive for installation

In addition, Adobe Systems recommends the 
following:

 

•

 

A Pentium-based processor

 

•

 

16 MB of RAM available to Persuasion

 

•

 

40 MB of free hard-disk space

 

•

 

A 16-bit (or greater) graphics card

 

•

 

An 8-bit (or greater) sound card

 

Registration

 

So that we can provide you with the highest-
quality software, offer technical support, and keep 
you informed about new software developments, 
please return the enclosed warranty registration 
card or follow the on-screen instructions to regis-
ter online. 

 

The Adobe Persuasion package 
contents

 

The Adobe Persuasion software package contains 
the following software and documentation:

 

•

 

The Adobe Persuasion CD-ROM, which 
includes Adobe Persuasion, Adobe Type Manager, 
Acrobat Reader and Distiller, Adobe PostScript 
printer drivers, Persuasion Player, QuickTime, 
Adobe Chart, Adobe Table, and PowerPoint File 
Converter

 

•

 

Adobe Persuasion 4.0 Getting Started

 

•

 

Adobe Persuasion 4.0 User Guide

 

•

 

Adobe Persuasion Quick Reference Card

 

•

 

Registration Card

 

•

 

A second CD-ROM containing useful products 
from third-party developers, including clip art and 
digital images
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Installing and Starting 
Adobe Persuasion 4.0

 

o use Persuasion 4.0, you must install the 
program onto your hard disk. You cannot 
run Persuasion from a CD-ROM drive. 

When you install Persuasion 4.0, be sure to use 
the correct serial number for your platform; the 
Macintosh and Windows versions have different 
numbers. Serial numbers are printed on the 
registration card and inside the front cover of the 
user guide. If you are upgrading, you can find 
your current serial number by running an earlier 
version of Persuasion and choosing About 
Persuasion from the Apple menu or, for Win-
dows, from the Help menu.

 

Upgrading to 
Adobe Persuasion 4.0

 

If you’re upgrading to Adobe Persuasion 4.0 and 
plan to remove the current version from your hard 
disk, there are some files you may want to continue 
to use. To keep a default autotemplate, clip art, or 
previously created presentation, be sure they are 
not in the Persuasion folder before you remove the 
previous version.

To convert existing Persuasion files for use with 
Persuasion 4.0, see “Converting presentations” on 
page 6.

 

Installing and starting 
Persuasion on a Macintosh

 

Use the following steps to install Persuasion 4.0 on 
a Macintosh. 

 

To install Persuasion 4.0 on a Macintosh:

 

1

 

Quit any running applications on your 
computer and turn off virus-protection software. 

 

2

 

Insert the CD-ROM into your CD-ROM drive.

 

3

 

Double-click the Install Persuasion 4.0 icon. 

 

4

 

Follow the on-screen instructions.

 

5

 

To register the application online, follow the on-
screen instructions. 

For a full list of names and locations of the files 
that have been installed with Persuasion 4.0, read 
the Installer Log in the Persuasion 4.0 folder.

 

Note:

 

 If you use AutoDoubler from Symantec 
Corporation, use AutoDoubler’s Exclusion feature 
to exclude the following Persuasion files from 
compression: AGMLib (or AGMLibPPC), JPEGLib 
(or JPEGLibPPC), and PMImageLib (or PMIm-
ageLibPPC). These files must be uncompressed to 
launch Persuasion. For information on the Exclusion 
feature, see the AutoDoubler documentation.

T
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Installing and Starting Adobe Persuasion 4.0

 

To start Persuasion 4.0 on a Macintosh:

 

Open the Adobe Persuasion 4.0 folder and double-
click the Persuasion program icon. The Persuasion 
startup screen appears. From this screen you can 
choose to open an existing presentation or create a 
new one.

If you are new to Persuasion, refer to Chapter 1 of 
the user guide for a tour with step-by-step instruc-
tions for creating a presentation.

 

Installing and starting 
Persuasion in Windows

 

Use the following steps to install Persuasion 4.0 in 
Windows.

 

To install Persuasion 4.0 on a computer running 
Windows:

 

1

 

Exit from any running applications on your 
computer and turn off virus-protection software.

 

2

 

Insert the CD-ROM into your CD-ROM drive.

 

3

 

Using Windows Explorer (Windows 95) 
or File Manager (Windows 3.1), double-click 
the Setup.exe icon in the root directory of the 
CD-ROM.

 

4

 

Follow the on-screen instructions.

 

5

 

To register the application online, follow the 
on-screen instructions. 

 

To start Adobe Persuasion 4.0 in Windows:

 

1

 

Do one of the following:

 

•

 

In Windows 95, choose Start > Programs > 
Adobe > Adobe Persuasion 4.0.

 

•

 

In Windows 3.1, open the Adobe group in 
Program Manager. Double-click the Adobe 
Persuasion program icon. 

 

2

 

The Persuasion startup screen appears. From 
this screen you can choose to open an existing 
presentation or create a new one.

If you are new to Persuasion, refer to Chapter 1 of 
the user guide for a tour with step-by-step instruc-
tions for creating a presentation.

 

Note: 

 

If you intend to have QuickTime movies in 
a PDF file you create in Windows 95, you should 
install 32-bit QuickTime. The installer for 32-bit 
QuickTime is located in the QT32 folder on the 
Persuasion CD-ROM.

 

Network installation

 

A network administrator can make Persuasion 4.0 
available to network users in two ways:

 

•

 

Install Persuasion 4.0 and its resource files on 
a network server. Users can then run Persuasion 
directly from the network. On the Macintosh, 
only one user at a time can run Persuasion 
from a single network installation. Multiple 
users are supported under Windows.

 

•

 

Copy Persuasion 4.0 files to the network server. 
Users can then install Persuasion onto their hard 
disk themselves.
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To install Persuasion 4.0 onto a network server:

 

Follow the instructions for installing Persuasion 
4.0 for the Macintosh or Windows. For Install 
Location (Macintosh) or Destination Directory 
(Windows), locate the desired network folder 
where Persuasion will reside.

Users with a valid license agreement can run Per-
suasion from the network by double-clicking the 
program’s icon. However, users will not be able to 
run the other applications that came with Persua-
sion (such as ATM and the PostScript Printer 
Driver) from the network. They will need to install 
these onto their individual hard disks.

 

To copy Persuasion 4.0 onto a network:

 

1

 

Insert the CD-ROM into the CD-ROM drive.

 

2

 

Drag the Adobe Persuasion 4.0 folder (Macin-
tosh) or the PN4 folder (Windows) to the desired 
network folder where the Persuasion files will 
reside.

Users with a valid license agreement can install 
Persuasion 4.0 onto their hard disk by following 
the instructions for installing Persuasion 4.0 
above. The only difference is that they will find the 
Install Persuasion 4.0 icon (Macintosh) or the 
setup.exe file (Windows) in the network folder 
instead of on the CD-ROM.

 

Creating a disk set for installing 
Persuasion 

 

You may want to run Persuasion 4.0 from a com-
puter without a CD-ROM drive. The Persuasion 
4.0 CD-ROM has a folder of Persuasion 4.0 disk 
images (Macintosh) and compressed files (Win-
dows) for copying onto formatted floppy disks. 
You can then install Persuasion 4.0 from the disk 
set. The folder also contains images and files for 
installing QuickTime and Adobe Type Manager 
(ATM).

 

To copy the Persuasion 4.0 disk images onto 
floppy disks:

 

1

 

Do one of the following:

 

•

 

In Windows, open the Diskimag folder. The 
folder contains folders named for each disk image.

 

•

 

On the Macintosh, open the Adobe Persuasion 
4.0 folder. The folder contains folders named for 
each disk image.

 

2

 

Open the first disk image folder, Disk01.

 

3

 

Copy the folder contents to a blank, formatted 
floppy disk. Name each disk with the exact name 
of the corresponding folder on the Persuasion 4.0 
CD-ROM. For example, the first disk would be 
labelled Disk01.

 

4

 

Repeat steps 2 and 3 for each subsequent folder 
and floppy disk.
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Installing and Starting Adobe Persuasion 4.0

 

To install Persuasion from a disk set:

 

1

 

Insert Disk01 into the computer onto which 
you want to install Persuasion 4.0. Double-click 
the Install Persuasion 4.0 icon (Macintosh) or 
use Explorer (Windows 95) or File Manager 
(Windows 3.1) to locate and double-click 
Setup.exe to begin installation.

 

2

 

Follow the on-screen instructions.

 

Troubleshooting installation

 

If you have problems installing Persuasion 4.0, try 
one or more of the following:

 

•

 

Check the Read Me file on the CD-ROM for any 
late-breaking news about installing Persuasion. 
Additional technical support information can be 
found in the Technical Support folder on the 
Persuasion CD-ROM.

 

•

 

Check that your system, hard-disk space, and 
available RAM meet or exceed those required for 
running Persuasion. Requirements are listed on 
pages 1 and 2.

 

•

 

Remember that you must install Persuasion onto 
your hard disk; you cannot run it from your CD-
ROM drive. 

 

•

 

Remove the CD-ROM from your computer and 
wipe it off with a soft cloth to ensure that it is free 
from paper dust or fingerprints.

 

•

 

Check to see that you are using the appropriate 
serial number for your platform; the Macintosh 
and Windows versions have different numbers.

 

•

 

Macintosh only: Turn off all extensions except 
the Apple CD-ROM extension and then restart 
your computer.

 

•

 

Windows 95 only: Restart Windows in safe 
mode.

 

Converting presentations

 

If you remove the earlier program from your hard 
disk, you will not be able to open your current pre-
sentations and autotemplates by double-clicking 
their icons. However, you can still open these files 
from within Persuasion. To resolve this problem, 
convert these files to Persuasion 4.0.

 

To convert files created using earlier versions:

 

1

 

Start Persuasion 4.0.

 

2

 

Click Open in the initial startup screen. In the 
Open dialog box, select the Persuasion 2.1 or 3.0 
file you want to convert. The file opens as an 
untitled file.

 

3

 

Save the untitled file under a new name.

 

Note:

 

 If you want to convert Microsoft PowerPoint 
presentations to Persuasion 4.0, see “Using the 
PowerPoint File Converter” on page 19.
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What’s New in Adobe Persuasion 4.0 

 

dobe Persuasion 4.0 is a powerful graphics 
software package that will help you create, 
assemble, and deliver professional, high-

quality World Wide Web pages, on-screen presen-
tations, 35mm slides, and overheads. 

 

What’s new

 

With Persuasion 4.0, you can show presentations 
on the Web, easily drag and drop graphics and 
multimedia elements, and fine-tune colors and 
transitions.

 

Multimedia Web authoring 

 

Use the Adobe Portable Document Format 
(PDF) to create exciting pages that can be viewed 
with a Web browser for the Internet and corpo-
rate intranets, incorporating movies, sounds, 
hyperlinks, and other graphically rich elements 
into your pages. 

Persuasion 4.0 also offers customizable autotem-
plates designed for the Internet, which include 
coordinated colors, backgounds, and other graph-
ical elements.

You can also drag and drop URL addresses from 
your Internet browser into your slide or presenta-
tion to let your audience connect to other sites in 
one click. 

For more information, see Chapter 14, “Presenta-
tions for the Web and Acrobat PDF,” of the 

 

Adobe 
Persuasion 4.0 User Guide

 

.

 

Drag and drop graphics and multimedia 
elements

 

Easily place graphics or multimedia elements in 
your presentation by simply dragging the file from 
the desktop into a Persuasion presentation. For 
more information, see “Importing graphics using 
the drag and drop feature” in Chapter 4 of the 

 

Adobe Persuasion 4.0 User Guide

 

.

 

Eyedropper tool 

 

Match colors easily with the Adobe standard eye-
dropper tool, which lets you designate a new color 
or edit an existing one by sampling colors from 
on-screen images. For more information, see 
“Sampling colors from imported graphics” in 
Chapter 7 of the 

 

Adobe Persuasion 4.0 User Guide

 

.

A
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What’s New in Adobe Persuasion 4.0

 

Variable-speed transition effects 

 

Control how slowly or quickly transition effects 
occur between slides. No longer is the speed deter-
mined by the presentation hardware alone. For 
more information, see “Setting visual transition 
effects” in Chapter 8 of the 

 

Adobe Persuasion 4.0 
User Guide

 

.

 

Layers palette

 

Layer slides more efficiently using the Layers pal-
ette. You can lock objects on a layer, as well as dis-
play objects only on a given layer. For more infor-
mation, see “Using the Layers palette” in Chapter 8 
of the 

 

Adobe Persuasion 4.0 User Guide

 

.

 

Nudge palette

 

Reposition or resize text and objects precisely 
using pixel-based nudge controls in Windows 
now, as well as on the Macintosh. For more infor-
mation, see “Modifying objects” in Chapter 6 of 
the 

 

Adobe Persuasion 4.0 User Guide

 

.

 

Reusing slides and slide objects 

 

You can now place objects onto the pasteboard so 
they are available to all slides in the presentation. 
You can also drag and drop entire slides between 
presentations in Slide Sorter view. For more infor-
mation, see “Using the pasteboard” in Chapter 3 
and “Importing slides from other Persuasion pre-
sentations” in Chapter 4 of the 

 

Adobe Persuasion 
4.0 User Guide

 

.

 

Cropping tool

Crop an imported image to designate a specified 
portion of the graphic for viewing and printing on 
the Macintosh, as well as in Windows. After you 
crop a graphic, you can control which portions of 
it appear by moving the graphic within the frame. 

What’s different
Find and use the tools you need easily through a 
variety of interface enhancements that make Per-
suasion look and work like other Adobe software. 
Many palettes and keyboard shortcuts now match 
those in Photoshop and Adobe Illustrator. The 
menus are organized more logically, and dialog 
boxes have been refined. 

Help

Persuasion Help on the Macintosh is now under 
the Apple Guide (question mark) menu rather 
than the Apple menu. Help for Adobe Chart and 
Adobe Table are under the Apple menu.

File menu

The Export command lets you export files to sev-
eral graphics formats, as well as Acrobat PDF, so 
you can place your presentations on the Web. For 
more information, see “Creating PDF files” in 
Chapter 14 and “Exporting a presentation” in 
Chapter 15 of the Adobe Persuasion 4.0 User Guide.
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The File Info command lets you review and edit 
transitions, fonts, and links throughout your 
presentation. For more information, see Chapter 
2, “Basic Concepts”; “Setting visual transition 
effects” in Chapter 8; and “Managing linked 
files” in Chapter 6 of the Adobe Persuasion 4.0 
User Guide.

The Preferences command now provides a central 
location for choosing defaults. Here you can 
choose a default autotemplate and Web browser or 
select ruler units and display options. The Slide 
Show dialog box has also moved from its previous 
location under the View menu. For more informa-
tion, see “Setting preferences” in Chapter 3, 
“Working with autotemplates” in Chapter 9, and 
“Using the Web” in Chapter 14 of the Adobe Per-
suasion 4.0 User Guide.

Type menu

The menu previously called the Text menu is now 
the Type menu. Its new organization provides easy 
access to text formatting functions. 

Object menu

The Draw menu is now the Object menu and con-
tains commands that apply to the selected object.

Options menu

This menu contains the view-specific features pre-
viously in the Outline, Master, Sorter, and Slide 
Show menus. The contents of this menu change 
depending on the current view.

Window menu

You can now set options for magnification and for 
displaying palettes using the Window menu.
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Improving Performance

 program’s performance is measured by 
the amount of time that it takes to com-
plete certain operations, such as opening 

a file or redrawing the screen after you switch to 
another slide in your presentation. In part, perfor-
mance is determined by the type of computer you 
are using and the amount of memory available to 
the program. Other factors that can dramatically 
affect Adobe Persuasion’s performance are how 
you set up your software and how you use the 
available RAM.

Maintaining adequate space on 
your hard disk
When you work with Persuasion, the program 
stores temporary files on your hard disk. Complex 
presentations rich with graphic elements require 
more space than presentations with mostly text. If 
you commonly use pictures, sound, or video you 
will need to have plenty of free space available dur-
ing a work session to prevent slow performance.

Changing application memory 
size (Macintosh only)
If your computer has more than the minimum 
amount of RAM required, you can improve the 
program’s performance by increasing the applica-
tion memory size.

To change Persuasion’s application memory size:

1 Select the Persuasion icon, and then choose 
File > Get Info.

2 Under Memory Requirements, set the Preferred 
Size option to up to double the Suggested Size.

3 Close the Persuasion Info window.

Speeding up screen redraw
Graphics can significantly slow down your work-
ing speed. You can hide or simplify graphics tem-
porarily while you work to speed up screen redraw.

Hiding complex layers

You can use the Layers Palette to make layers tem-
porarily invisible to speed screen redraw. Layers 
with complex graphics and charts are particularly 
slow to redraw.

To hide a layer that is visible, click the eye icon in 
the first column on the Layers palette.

Simplifing the display of graphics

You can change settings in General Preferences 
(choose File > Preferences > General) to simplify 
the display of graphics. In the Image Display sec-
tion, choose Standard or Gray Out. On the Macin-
tosh, in the Options section, deselect Fine Back-
ground Fill. These choices will decrease the clarity 
of the graphics in your presentation until you 
revert the preferences.

A
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Using Adobe Type Manager

he Adobe Persuasion package includes 
Adobe Type Manager (ATM) 4.0 software. 
ATM is a font utility that generates high-

quality screen fonts from outline font data and 
lets you print Type 1 fonts on non-PostScript 
printers. The version included with Persuasion is 
not the full retail package (available separately 
from Adobe): it supports anti-aliasing, but lacks 
the font management capabilities (including acti-
vation of inactive fonts when the font is required 
by a document) available in the Deluxe version 
of ATM.

ATM is installed when you choose the Typical 
install option for Persuasion or when you choose 
the Custom install option and specifically select 
the ATM install option. There are different ver-
sions of ATM that come with Persuasion 4.0. The 
correct version for your operating system is auto-
matically installed when you install Persuasion. 

Using ATM on a Macintosh
The following instructions will help you make 
the most of your ATM program when using a 
Macintosh.

Adding and removing fonts

ATM uses the font files stored in the Fonts folder 
in your System folder. To add fonts, simply drag 
the font files into the folder and restart your com-
puter. To remove fonts, drag the font files from the 
Fonts folder. 

Removing ATM

You can easily remove the ATM control panel. 
Removing ATM does not delete any font files from 
your system, but it may prevent fonts from dis-
playing and printing properly.

To remove ATM from your system:

1 Drag the ATM control panel from the Control 
Panel folder onto the desktop. 

2 Restart your Macintosh; then drag the icons to 
the Trash.

T
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Selecting ATM options

ATM includes features that ensure you get the font 
you want on screen and from the printer. You can 
customize these and other features to suit your 
work style.

To customize ATM for the Macintosh:

1 Double-click the ATM icon in the Control 
Panels window.

2 Select from the following ATM options:

• Click On or Off to turn the ATM software on and 
off. When ATM is off, Type 1 fonts will not be 
rasterized by ATM.

• Adjust the Character Cache Size to set the 
amount of system memory available to store 
bitmap characters created by the ATM program. 
The default setting is 256K.

• Select Line Spacing (the default) in the 
Preserve section to make accented characters 
fit within the current line height and to retain 
the same line and page breaks within a docu-
ment. This option may clip the descenders of 
some characters. Select Character Shapes in the 

Preserve section to prevent clipping and to 
increase the size of the current line height to 
accommodate larger characters.

• Select Smooth Font Edges On-Screen to improve 
the appearance of Type 1 fonts on-screen by 
smoothing out the jagged edges inherent in video 
displays. The new version of ATM uses anti-
aliasing—a technique for blending colors along an 
edge to provide a smoother, softer edge to your 
Type 1 fonts on-screen. Although anti-aliasing can 
make screen fonts appear smoother, using this 
feature can slow down screen-redraw of type-
intensive slides. In that case, it may help to increase 
your font cache. To display properly, you will need 
to set your monitor to greater than 256 colors. 

• Select Precision Character Positioning to make 
ATM position characters at the sub-pixel level to 
display more accurate spacing, especially at small 
point sizes. Selecting this option may slow down 
screen-redraw of type-intensive slides on some 
systems. Not all applications support sub-pixel 
positioning.

• Select Enable Font Substitution to have ATM use 
the special Adobe multiple master fonts to mimic 
a version of a font not found when a document 
was opened. This font version provides the same 
spacing and line breaks, but may not appear the 
same as the required font. If this option is not 
selected, the application or other system software 
may attempt to perform font substitution. 

Note: This option is available only if you have a 
previous version of SuperATM or the Deluxe version 
of ATM installed on your computer.

3 Restart your computer. 
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Using ATM in Windows 95
The following instructions will help you make the 
most of ATM when using Windows 95.

Adding and removing fonts

Using ATM, you can install or remove fonts from 
your system. 

To add fonts:

1 Choose Start > Programs > Adobe > Adobe 
Type Manager.

2 In ATM, click the Fonts tab.

3 Choose Browse for Fonts from the Source drop-
down list to add fonts from a local hard disk, CD-
ROM, floppy disk, or network drive. Locate the 
folder that contains the font files you want.

4 Drag and drop the selected fonts to the list on 
the left, or select a font and click Add. 

Note: Select the Add Without Copying Files option to 
use fonts without copying them to your hard disk. 
This is useful when you want to temporarily install a 
font or when you use a font that is located on a 
network server or a CD-ROM.

To remove fonts:

1 In ATM, click the Fonts tab.

2 Select the fonts you want to remove.

3 Click the Remove button. You can also right-
click a font or a selection of fonts and choose 
Remove.

4 For each font in your selection, ATM prompts 
you. To delete font files, select Remove Font Files 
from Disk. If you’re not sure whether the font files 
are on your own disk or on a network disk, click 
Properties for more information. Click Yes or Yes 
To All.

Removing ATM

You can remove the ATM program from your 
system easily. Uninstalling ATM does not delete 
any font files from your system, but it may prevent 
fonts from displaying and printing properly. If you 
want to remove fonts from your hard disk, you 
should remove them using ATM instead of unin-
stalling ATM.
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To remove ATM:

1 In ATM, click the Settings tab.

2 Click Uninstall ATM.

3 Click Begin Uninstall. Follow the remaining on-
screen instructions.

Selecting ATM options

ATM includes features that ensure you get the font 
you want on screen and from the printer. You can 
customize these and other features to suit your 
work style.

To customize ATM for Windows 95:

1 In Windows 95, choose Start > Programs > 
Adobe > Adobe Type Manager.

2 Click the Settings tab.

3 Select from the following ATM options:

• Click On or Off to turn the ATM software on and 
off. When ATM is off, only non-Type 1 fonts 
appear on-screen.

• Adjust the Font Cache to set the amount of 
system memory ATM uses to store font data. A 
large font cache may speed up scrolling and other 
screen displays of fonts but can limit the amount 
of memory available to other applications. The 
default setting is 256K.

4 Click Advanced and choose from the following 
options:

• Select the Smooth Font Edges On-Screen option 
to improve the appearance of Type 1 fonts on-
screen by smoothing out the jagged edges inherent 
in video displays. ATM uses anti-aliasing—a tech-
nique for blending colors along an edge to provide 
a smoother, softer edge to your Type 1 fonts on-
screen. Although anti-aliasing can make screen 
fonts appear smoother, using this feature can slow 
down screen redraw of type-intensive slides. In 
that case, set your display color palette to High 
Color or better, or turn off font smoothing.

• Select Print Fonts as Graphics to send fonts to 
the printer as graphic images rather than down-
loading the font file itself. This setting may help 
older PCL printers that cannot use downloadable 
fonts or when printing documents with mixed text 
and graphics that don’t print correctly. Printing 
time may increase.

• Select Display Fonts as Graphics to send fonts to 
your monitor as graphic images instead of gener-
ating screen fonts from the font files. Use this 
setting only if you are having difficulty with on-
screen font displays. Screen redraw time may 
increase slightly.
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• Select Use Pre-Built or Resident Fonts if you use 
bitmap fonts installed in Windows for screen fonts 
and bitmap fonts resident in the printer for 
printing. Bitmap fonts take up hard-disk space but 
can help certain applications display and print 
documents more quickly.

• Select the Check for New or Removed Type 1 
Fonts when Starting ATM option to instruct ATM 
to manage PostScript fonts installed or removed 
by another program. If this option is selected, then 
when ATM starts, new fonts installed by another 
program will be added to the ATM font list.

5 Restart your computer.

Setting download options for the 
Microsoft PostScript printer driver

If you use the Microsoft PostScript printer driver, 
you can determine if fonts will be downloaded to 
the printer at print time. This choice can affect 
whether you get the correct font to print from the 
printer. In ATM, click the Settings tab and then 
click MS PostScript Driver. The options in this dia-
log box affect all future fonts you add, but do not 
affect currently installed ones. The default setting, 
Mark as Autodownload for PostScript Printer, 
ensures your document prints with the proper 
fonts. For more information, click Help.

Using ATM in Windows 3.1
Using ATM, you can add and remove fonts from 
your system.

Adding and removing fonts

The fonts that came with Persuasion 4.0 were 
installed on your computer when you installed 
Persuasion. However, you may want to use ATM to 
add fonts from a different source.

To add fonts:

1 Double-click the ATM icon in the Main 
program group.

2 Click Add.
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3 Use the Directories list box to locate the desired 
fonts from a local hard disk, CD-ROM, floppy 
disk, or network drive. Locate the folder that 
contains the font files you want. To see fonts listed, 
select a folder containing .pfm files.

4 Select the fonts you want to add.

5 If you want to use fonts without copying them 
to your hard disk, select the Install Without 
Copying Files option. This is useful if you want to 
use fonts on a network drive or CD-ROM without 
taking up space on your own hard disk.

6 Click Add.

To remove fonts:

1 Double-click the ATM icon in the Main 
program group.

2 Select the fonts you want to remove.

3 Click Remove.

4 Select Delete Font Files from Disk if you want to 
permanently remove these fonts from your hard 
disk. Click Yes.

Removing the ATM program from your 
Windows 3.1 system

You can remove the ATM program from your sys-
tem by deleting several program and font files and 
by editing the SYSTEM.INI file.

To remove ATM:

1 Remove Type 1 fonts from your system by 
following the previous instructions. 

2 Make a backup copy of the SYSTEM.INI file in 
your Windows directory. Name it something that 
does not conflict with an existing file. 

3 Use Notepad or another text-editing program to 
open the SYSTEM.INI file.

4 Remove the following two lines, which are 
located in the BOOT section of the 
SYSTEM.INI file:

system.drv=atmsys.drv
atm.system.drv=system.drv

Replace the two removed lines with this single line:

system.drv=system.drv

See the file TECHREF.WRI for more information.

5 Save the SYSTEM.INI file as a plain text file. 
(The Notepad program does this automatically.)

6 Quit Notepad and exit Windows.

7 Delete ATM16.DLL, ATM32.DLL, and 
ATMSYS.DRV from your Windows System direc-
tory. If you have had ATM version 1.x on your 
system, you may also need to delete ATM.DLL.

8 Delete ATM.INI and ATMCNTRL.EXE from 
your Windows directory.

9 Delete the ATMFONTS.QLC file from the direc-
tory that contained the PFB files. The default 
directory is PSFONTS.
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Selecting ATM options

ATM includes features that ensure you get the font 
you want on screen and from the printer. You can 
customize these and other features to suit your 
work style.

To customize ATM for Windows 3.1:

1 In Program Manager, double-click the ATM 
icon in the Main program group.

2 Select from the following ATM options:

• Click On or Off to turn the ATM software on and 
off. By default ATM is turned on upon installation, 
but you can turn it off at any time. 

• Adjust the Font Cache to set the amount of 
system memory ATM uses to store font data. 
A large font cache may speed up scrolling and 
other screen displays of fonts but can limit the 
amount of memory available to other applica-
tions. The default cache size is 256K. 

• Select Use Pre-Built or Resident Fonts to use 
bitmap fonts installed in Windows for screen fonts 
and bitmap fonts resident in the printer for 
printing. Bitmap fonts take up hard-disk space but 
can help certain applications display and print 
documents more quickly.

• Select Print ATM Fonts as Graphics to send fonts 
to the printer as graphic images rather than down-
loading the font file itself. This setting may help 
older PCL printers that cannot use downloadable 
fonts or when printing documents with mixed text 
and graphics that don’t print correctly. Printing 
time may increase.

Creating multiple master fonts
The Create MM Instances option in ATM lets you 
create customized renditions of fonts. Depending 
on their design, multiple master fonts have one or 
more controls to vary certain attributes, such as 
width, height, or weight. You can use multiple 
master fonts as you would any other PostScript 
Type 1 font.

About multiple master font designs

A multiple master font consists of one or more 
instances of the font. An instance is a particular 
rendition of the font that varies from other 
instances in one or more attributes.

Each multiple master font includes ready-to-use 
primary instances that constitute a complete type-
face family. The typeface designer or manufacturer 
determines the selection of primary instances to 
provide a useful palette of fonts.
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Each multiple master has one or more design 
axes (which you can see in ATM once the font 
is installed). A design axis is a variable type-
face attribute, such as weight, width, style, or 
optical size.

Multiple master instances are named in the format 
Family_design coordinates, where Family is the 
name of the typeface and design coordinates iden-
tifies a particular instance by a string of numbers 
and letters. 

The design coordinates consist of alphanumeric 
combinations for each design axis in the font. If 
the font has a single design axis, there is a single 
alphanumeric combination (for example, 240 RG 
for Regular weight). If there are two design axes, 
there will be two alphanumeric combinations, and 
so on.

Within the design coordinate name, the numbers 
indicate the position of the instance along the 
design axis. The letters indicate style (such as reg-
ular, bold, condensed) for a primary instance or 
the design axis (such as weight, width, optical size) 
for a custom instance.

The labels for primary instances included in a 
multiple master font package use uppercase abbre-
viations (XL for Extra-Light), and custom 
instances use generic lowercase abbreviations (wt 
for weight and wd for width).

Note: Some font menus and lists in applications are 
limited in width. Longer instance names may appear 
clipped.

Creating and removing custom instances

You create custom instances by using controls in 
ATM to modify design axes of primary instances.

To create a custom instance:

1 Do one of the following:

• On the Macintosh, open the ATM control panel 
and click the Create MM Instances button. Choose 
the multiple master font you want to work with.

• In Windows 95, start ATM and click the Fonts 
tab. Choose Create Multiple Masters from the 
Source menu. From the Multiple Master Base Font 
menu, choose the multiple master font you want 
to work with.

• In Windows 3.1, start ATM and click Create. 
From the Type menu, choose the multiple master 
font you want to work with.

2 Use the slider controls to modify the instance. 
Different fonts provide different controls. The 
sample text changes as you move the sliders.

3 When you are satisfied with the new instance, 
do one of the following:

• On the Macintosh, click Create and then 
click OK.

• In Windows 95, click Add. 

• In Windows 3.1, click Add and then click Close.
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Using the PowerPoint  File Converter

ou can easily convert presentations that 
were produced in Microsoft PowerPoint® 
version 4 into Persuasion files by using the 

PowerPoint File Converter. It does not matter 
which platform, Windows or Macintosh, the pre-
sentations were created on or are being translated 
to. To translate a PowerPoint 7.0 presentation, you 
must save it in PowerPoint 4.0 format before you 
convert it.

Some files will require OLE 2, which is installed 
with Microsoft Windows 95, Word, Excel, or Pow-
erPoint. If you do not have one of these applica-
tions, you can find OLE 2, along with installation 
instructions, on the Persuasion CD-ROM.

There are two ways to convert PowerPoint presen-
tations into Persuasion. One is by opening the 
PowerPoint File Converter program and selecting 
files to convert, and the other is by dragging and 
dropping files onto the program’s icon.The con-
verter program is a separate program and you will 
use it outside of Persuasion.

To open the PowerPoint File Converter:

1 Double-click the PowerPoint File Converter 
icon, which is in the same folder as Persuasion 4.0. 
In Windows, the filename for the converter is 
Pptflt1.exe.

2 Click Add.

3 Locate and select the file you want to convert 
and then click OK. This returns you to the Power-
Point to Persuasion File Conversion dialog box.

Note: If you decide not to convert some of the files, 
you can select them and click Remove.

4 Click Browse to choose a folder for the 
converted files.

5 Click Start Conversion.

A dialog box indicates how many files were 
converted. 

The converter makes copies of the PowerPoint files 
and then converts the copies to an interchange for-
mat that can be read by either Persuasion 4.0 for 
Windows or Persuasion 4.0 for the Macintosh. The 
converted files will have a .prf filename extension. 
The original PowerPoint files are not altered.

®

Y



GETTING STARTED20
Using the PowerPoint File Converter

To drag and drop (Macintosh or Windows 95):

1 Locate and select the PowerPoint files you want 
to convert.

2 Drag and drop them on the PowerPoint File 
Converter icon, which is in the same folder as 
Persuasion 4.0. In Windows, the filename for the 
converter is Pptflt1.exe.

3 In the PowerPoint to Persuasion File Conver-
sion dialog box, click Browse to choose a directory 
for the converted files.

4 Click Start Conversion.

A dialog box indicates how many files were 
converted.

To drag and drop (Windows 3.1):

1 Open File Manager.

2 Copy the PowerPoint files to be converted to the 
PN4 directory.

3 Open the PN4 directory and drag and drop the 
PowerPoint files on the Pptflt1.exe file icon.

What to expect
Some items may change significantly during con-
version. The following are some of the possible 
changes that may occur:

• Objects that have been rotated or flipped in 
PowerPoint will transfer as they were originally 
drawn. You can then use Persuasion’s tools to 
rotate or flip them as you choose.

• Colors may look slightly different in Persuasion 
than they did in PowerPoint and patterns may 
look quite different.

• PowerPoint Outline Masters will not transfer 
into Persuasion.

• Text formatting, such as bold and italics, will not 
transfer.

• OLE-2 embedded objects will transfer as OLE-1 
objects; OLE-2 linked objects will transfer as 
unlinked pictures.


